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Introduction

Vous pouvez saisir des données dans Calc de différentes manières : en utilisant le clavier, la 
souris (glisser et déposer), l'outil Remplir et les listes de sélection. Calc donne également la 
possibilité d'entrer de l'information dans plusieurs feuilles d'un même document en une seule fois.

Vous pouvez formater les données saisies et les afficher de plusieurs façons.

Saisir des données en utilisant le clavier

La plupart des saisies de données dans Calc peuvent être faites en utilisant le clavier.

Saisir des nombres
Cliquez dans la cellule et tapez le nombre en utilisant les touches numériques soit de la partie 
principale du clavier, soit du pavé numérique.

Pour entrer un nombre négatif, tapez le signe moins (–) devant lui ou entourez-le de parenthèses, 
comme ceci : (1234).

Par défaut, les nombres sont alignés à droite et les nombres négatifs commencent par le signe 
moins.

Saisir des textes
Cliquez dans la cellule et tapez le texte. Les textes sont alignés à gauche par défaut.

Pour saisir un texte de plusieurs lignes dans une cellule, vous pouvez insérer des retours à la ligne 
en tapant Ctrl+Entrée.

Vous pouvez agrandir la zone de saisie en cliquant sur l'icône Étendre la barre Formule . La 

zone de saisie devient alors multi-lignes (Figure 1). Cliquez à nouveau sur l'icône  pour revenir à 
la zone de saisie initiale.

Figure 1 : Zone de saisie multi-lignes

Saisir des nombres en tant que textes
Si un nombre est saisi dans le format 01481, Calc supprimera le 0 devant ce nombre. (Exception : 
voir l'Astuce ci-dessous.) Pour conserver le 0 de devant, par exemple pour un numéro de 
téléphone, vous pouvez soit :

• assigner le format texte à la cellule (Format > Cellules > Nombres et choisir la catégorie 
Texte) et taper ensuite le nombre, comme ceci : 01481.

• taper une apostrophe (guillemet simple) devant le nombre, comme ceci : '01481. 
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La donnée est désormais traitée comme un texte et est affichée exactement comme elle a été 
saisie. Par conséquent, les formules considéreront cette saisie comme un zéro et les fonctions 
l'ignoreront.

Astuce

Les nombres peuvent commencer par des zéros et être toujours considérés 
comme des nombres (et non comme des textes) si la cellule est formatée de façon 
appropriée. Faites un clic droit dans la cellule et choisissez Formater les cellules 
> Nombres. Ajustez le paramétrage Zéros non significatifs pour ajouter des zéros 
au début des nombres.

Note

Quand une apostrophe est utilisée pour permettre l'affichage d'un 0 au début d'un 
nombre, elle n'est pas visible dans la cellule dès lors que la touche Entrée est 
appuyée. Si des “guillemets intelligents” sont utilisés comme apostrophes, 
l'apostrophe restera visible dans la cellule.

Pour choisir ce type d'apostrophe, utilisez Outils > Options d'AutoCorrection > 
Options linguistiques. Cochez Remplacer les guillemets simples pour activer 
cette fonction. La sélection du type de guillemet simple s'appliquera à la fois à 
Calc et à Writer.

Attention Quand un nombre est formaté en tant que texte, prenez garde à ce que la cellule 
contenant ce nombre ne soit pas utilisée dans une formule, parce que Calc 
ignorera sa valeur.

Saisir des dates et des heures
Sélectionnez la cellule et tapez la date ou l'heure. Vous pouvez séparer les éléments de la date 
avec un slash (/) ou un tiret (–) ou utiliser un texte comme 10 octobre 03. Calc reconnaît plusieurs 
formats de date. Vous pouvez séparer les éléments de temps avec des deux-points comme 
10:43:45.

Les formats de dates reconnus par Calc peuvent être définis dans l'option Motifs d'acceptation de 
date dans Outils > Options > Paramètres linguistiques > Langues, avec les notations 
suivantes : D pour le jour, M pour le mois et Y pour l’année.

Saisir des caractères spéciaux
Un caractère “spécial” est un caractère qui ne se trouve pas sur un clavier français standard. Par 
exemple, © ¾ æ ñ ö ø ¢ sont tous des caractères spéciaux. Pour insérer un caractère spécial :

1) Placez le curseur dans votre document où vous voulez que le caractère apparaisse.

2) Cliquez sur Insertion > Caractères spéciaux pour ouvrir la boîte de dialogue Caractères 
spéciaux (Figure 2).

3) Sélectionnez un ou plusieurs caractères (depuis une police ou un sous-ensemble de 
polices) que vous voulez insérer ; puis cliquez sur OK. Les caractères sélectionnés sont 
affichés en bas à gauche de la boîte de dialogue. Quand vous sélectionnez un caractère, il 
est affiché seul en bas à droite, avec son code numérique associé.

Note
Les différentes polices comprennent des caractères spéciaux différents. Si vous 
ne trouvez pas le caractère spécial particulier que vous voulez, essayez de 
changer la sélection de Police.
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Figure 2 : Boîte de dialogue Caractères spéciaux

Insérer des tirets
Pour saisir des tirets moyens et longs, vous pouvez utiliser l'option Remplacer les tirets dans 
l'onglet Outils > Options d'AutoCorrection > Options. Cette option remplace deux traits d'union, 
sous certaines conditions, par le tiret correspondant.

Dans la table suivante, A et B représentent un texte constitué de lettres de A à z et de chiffres de 0 
à 9.

Texte que vous tapez : Résultat

A - B (A, espace, moins, espace, B) A – B (A, espace, tiret moyen, espace, B)

A -- B (A, espace, moins, moins, espace, B) A – B (A, espace, tiret moyen, espace, B)

A--B (A, moins, moins, B) A—B (A, tiret long, B)

A-B (A, moins, B) A-B (sans modification)

A -B (A, espace, moins, B) A -B (sans modification)

A --B (A, espace, moins, moins, B) A –B (A, espace, tiret moyen, B)

Désactiver les changements automatiques
Calc applique automatiquement plusieurs changements durant la saisie de données, à moins que 
vous n'ayez désactivé ces changements. Vous pouvez également annuler immédiatement chaque 
changement automatique avec Ctrl+Z.

Changements de l'AutoCorrection
La correction automatique des erreurs de frappe, le remplacement des guillemets doubles 
droits par des apostrophes courbes et le début de contenu de cellule avec une lettre majuscule 
sont contrôlés par Outils > Options d'AutoCorrection. Allez dans les onglets Options ou 
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Remplacer pour désactiver chaque caractéristique indésirable. Dans l'onglet Remplacer, vous 
pouvez également supprimer les paires de mots non souhaitées et ajouter de nouvelles paires.

AutoSaisie
Quand vous tapez du texte dans une cellule, Calc suggère automatiquement une occurrence 
trouvée dans la même colonne. Pour activer ou désactiver l'AutoSaisie, affichez ou enlevez 
une coche devant Outils > Contenu des cellules > AutoSaisie.

Conversion automatique des dates
Calc convertit automatiquement certaines saisies en dates. Pour s'assurer qu'une saisie qui 
ressemble à une date soit considérée comme un texte, formatez la cellule en texte ou tapez 
une apostrophe au début de la saisie.

Accélérer la saisie des données

La saisie de données dans un classeur peut demander beaucoup de travail, mais Calc fournit 
plusieurs outils pour alléger certaines corvées de saisie.

La fonctionnalité la plus simple est de faire glisser et déposer le contenu d'une cellule dans une 
autre avec la souris. Beaucoup de personnes trouvent également utile l'AutoSaisie. Calc recèle 
également plusieurs autres outils pour la saisie automatique, plus particulièrement pour les tâches 
répétitives. Ce sont l'outil Remplir, les listes de sélection et la possibilité de saisir de l'information 
dans plusieurs feuilles du document.

Utiliser l'outil Remplir dans les cellules
Au plus simple, l'outil Remplir est une façon de dupliquer un contenu existant. Commencez par 
sélectionner la cellule à copier, puis faites glisser la souris dans une direction (ou gardez appuyée 
la touche Maj et cliquez dans la dernière cellule que vous voulez remplir), et choisissez ensuite 
Édition > Remplir et la direction dans laquelle vous voulez effectuer la copie : Haut, Bas, Gauche 
ou Droite.

Figure 3 : Utiliser l'outil Remplir

Attention Les choix qui ne sont pas valables sont grisés, mais vous pouvez toujours choisir 
la direction opposée à celle que vous souhaitez, ce qui peut avoir comme 
conséquence d'écraser accidentellement des cellules.

8 Saisir, Modifier et Formater des Données



Astuce

Une manière rapide de remplir des cellules est de saisir la “poignée” dans le coin 
inférieur droit de la cellule et de la faire glisser dans la direction que vous voulez 
remplir. Si la cellule contient un nombre, alors des nombres rempliront les cellules 
selon une série. De même, si la cellule contient un texte, ce même texte remplira 
les cellules dans la direction que vous choisirez.

Utiliser une série de remplissage
Une utilisation plus complexe de l'outil Remplir est d'utiliser une série de remplissage. Des listes 
par défaut existent pour les jours de la semaine, complets et abrégés, et les mois de l'année, mais 
vous pouvez également créer vos propres listes.

Pour ajouter une série de remplissage à un classeur, sélectionnez les cellules à remplir, choisissez 
Édition > Remplir > Série. Dans la boîte de dialogue Remplir la série, sélectionnez Remplissage 
automatique comme Type de séries et entrez comme Valeur initiale un élément d'une série 
définie. Les cellules sélectionnées se rempliront alors en séquence avec les autres éléments de la 
liste, en se répétant depuis le début de la liste si la fin de la liste est atteinte.

Figure 4 : Spécifier le début d'une série de remplissage (résultats dans la Figure 5)

Figure 5 : Résultat de la sélection de la série de 
remplissage telle que Figure 4
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Vous pouvez également utiliser Édition > Remplir > Série pour créer une série de remplissage 
occasionnelle pour des nombres en saisissant les valeurs de début et de fin et l'incrément. Par 
exemple, si vous saisissez les valeurs de début et de fin de 1 et 7 avec un incrément de 2, vous 
obtiendrez la séquence 1, 3, 5, 7.

Dans tous les cas, l'outil Remplir crée seulement une liaison momentanée entre les cellules. Une 
fois qu'elles sont remplies, les cellules n'ont plus de liaison entre elles.

Définir une série de remplissage
Pour définir votre propre série de remplissage, allez à Outils > Options > LibreOffice Calc > 
Listes de tri. Cette boîte de dialogue affiche les séries précédemment définies dans le champ 
Listes sur la gauche, et le contenu de la liste en surbrillance dans le champ Entrées.

Figure 6 : Séries de remplissage prédéfinies

Cliquez sur Nouveau. Le champ Entrées est mis à blanc. Tapez les valeurs de la nouvelle liste 
dans le champ Entrées (une entrée par ligne), et cliquez ensuite sur Ajouter.

Figure 7 : Définir une nouvelle série de remplissage

Vous pouvez également définir une série de remplissage à partir d'une plage de cellules. Pour 
ceci, sélectionnez la plage de cellules qui contient les valeurs de la série, allez à Outils > Options 
> LibreOffice Calc > Listes de tri et cliquez sur Copier. Si la plage comporte plus d'une ligne et 
plus d'une colonne, la boîte de dialogue Copier la liste s'ouvre, vous demandant d'indiquer si la 
série se trouve en ligne ou en colonne.
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Utiliser les listes de sélection
Les listes de sélection sont disponibles uniquement pour les textes et sont 
limitées à l'usage de textes qui ont été déjà saisis dans la même colonne.

Pour utiliser une liste de sélection, sélectionnez une cellule vide et appuyez 
sur Alt+↓ (flèche bas) (versions précédentes : Ctrl+D ou Ctrl+Maj+D), ou 
faites un clic droit et choisissez Liste de sélection. Une liste déroulante 
apparaît, contenant toutes les cellules de la même colonne qui ont au moins 
un caractère de texte ou dont le format est défini comme texte. Les textes 
des cellules sont triés par ordre alphabétique et ceux qui ont des 
occurrences multiples n'apparaissent qu'une seule fois. Cliquez sur l'entrée 
dont vous avez besoin.

Fusionner des cellules

Vous pouvez sélectionner des cellules adjacentes et les fusionner en une seule. Pour ceci, vous 
pouvez sélectionner les cellules désirées et :

• Sélectionner Format > Fusionner les cellules > Fusionner les cellules dans la barre de 
menus.

• Faire un clic droit et choisir Fusionner les cellules dans le menu contextuel.

Si une des cellules autre que la première est remplie, un message s'affiche, vous proposant de 
déplacer le contenu des cellules cachées dans la première cellule. Vous pouvez accepter (le 
contenu des cellules est concaténé avec un espace de séparation), refuser (le contenu des 
cellules autres que la première est masqué) ou annuler l'opération.

Vous pouvez également sélectionner Format > Fusionner les cellules > Fusionner et centrer 
les cellules dans la barre de menus, ou cliquer sur le bouton Fusionner et centrer les cellules  

 de la barre d'outils Formatage, pour fusionner les cellules et centrer le contenu résultant.

Pour annuler la fusion de cellules, sélectionnez la cellule fusionnée et choisissez Format > 
Fusionner les cellules > Scinder les cellules dans la barre de menus ou cliquez sur le bouton 

Fusionner et centrer les cellules de la barre d’outils Formatage .

Partager du contenu entre différentes feuilles

Vous pouvez vouloir entrer la même information dans la même cellule de plusieurs feuilles, par 
exemple pour fixer des listes standard pour un groupe de personnes ou pour des organismes. Au 
lieu de saisir la liste individuellement dans chaque feuille, vous pouvez la saisir en une fois pour 
toutes les feuilles. Pour ce faire, sélectionnez les feuilles désirées (Édition > Feuille > 
Sélectionner et cliquez sur le nom des feuilles désirées en maintenant la touche Ctrl enfoncée), 
puis saisissez l'information dans la feuille courante.

Attention Cette technique écrase toute information qui se trouve déjà dans les cellules des 
autres feuilles, sans aucun avertissement. Pour cette raison, quand vous avez fini, 
assurez-vous de bien dé-sélectionner toutes les feuilles sauf celle que vous voulez 
modifier. (Ctrl+clic sur un onglet pour sélectionner ou dé-sélectionner la feuille.)
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Valider le contenu des cellules

Quand vous créez des classeurs pour que d'autres personnes les utilisent, vous pouvez vouloir 
vous assurer qu'elles saisissent des données qui sont valides ou appropriées pour la cellule. Vous 
pouvez également utiliser la validation pour votre propre usage comme guide pour saisir des 
données complexes ou rarement utilisées.

Les séries de remplissage et les listes de sélection peuvent convenir pour certains types de 
données, mais elles sont limitées aux informations pré-définies. Pour valider une nouvelle donnée 
saisie par un utilisateur, sélectionnez une cellule et utilisez Données > Validité pour définir le type 
de contenu qui peut être saisi dans cette cellule. Par exemple, une cellule peut nécessiter une date 
ou un nombre entier, sans caractère alphabétique ni point décimal ; ou bien encore une cellule ne 
doit pas être laissée vide.

Selon le paramétrage de la validation, l'outil peut aussi définir l'intervalle des valeurs qui peuvent 
être saisies, et fournir des messages d'aide qui expliquent les règles de validation que vous avez 
paramétrées pour cette cellule (ce que les utilisateurs devraient faire s'ils saisissent un contenu 
incorrect). Vous pouvez aussi paramétrer la cellule pour refuser un contenu incorrect, l'accepter 
avec un avertissement, ou, si vous êtes très organisé, exécuter une macro si une erreur est saisie.

Bien que leur contenu soit obtenu par calcul, vous pouvez définir une validation pour les cellules 
qui contiennent des fonctions. Le contrôle de validité ne se déclenchera pas lors du calcul mais 
vous pouvez utiliser Outils > Audit > Marquer les données incorrectes pour trouver les cellules 
avec des données incorrectes. La fonction Audit marque chaque cellule contenant des données 
incorrectes avec un ovale.

Figure 8 : Données incorrectes marquées par la fonction Audit

Notez qu'une règle de validité est considérée comme une partie du format de la cellule. Si vous 
sélectionnez Formats ou Tout supprimer depuis la boîte de dialogue Supprimer du contenu, alors 
elle sera supprimée (si la commande de l'Audit Marquer les données incorrectes est à nouveau 
effectuée, les ovales des données incorrectes disparaîtront, parce que la donnée n'est désormais 
plus incorrecte). Si vous voulez copier une règle de validité avec le reste de la cellule, utilisez 
Édition > Collage spécial > Formats ou Tout insérer.
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La Figure 9 montre les choix possibles pour un test de validité ordinaire. Notez l'option Autoriser 
les cellules vides sous la liste déroulante Autoriser.

Figure 9 : Choix d'un test de validité ordinaire

Les options d'un test de validité peuvent changer selon le type de données sélectionné dans la 
liste Autoriser. Par exemple, la Figure 10 montre les choix quand une cellule doit contenir une 
plage de cellules.

Figure 10 : Choix de validité pour une plage de cellules

Pour fournir une aide à la saisie pour une cellule, utilisez l'onglet Aide à la saisie de la boîte de 
dialogue Validité (Figure 11). Pour afficher un message d'erreur quand une valeur incorrecte est 
saisie, utilisez l'onglet Message d'erreur (Figure 12). Essayez d'écrire une remarque pertinente, 
expliquant ce qu'une saisie valide devrait contenir, et pas simplement “Données incorrectes. 
Réessayez” ou quelque chose de ce genre.
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Figure 11 : Définir une aide à la saisie pour une cellule

Figure 12 : Définir un message d'erreur pour une cellule avec une donnée incorrecte

Modifier les données

La modification des données se fait en gros de la même manière que leur saisie. La première 
étape est de sélectionner la cellule contenant les données à modifier.

Supprimer les données d'une cellule
Les données d'une cellule peuvent être effacées (supprimées) de plusieurs façons.

Supprimer les données seulement
Les données seules peuvent être supprimées dans une cellule sans affecter le formatage de la 
cellule. Cliquez dans la cellule pour la sélectionner et appuyez ensuite sur la touche Suppr.

Supprimer les données et le formatage
Les données et le formatage peuvent être supprimés d'une cellule en une seule fois. Appuyez 
sur la touche Retour arrière (ou faites un clic droit et choisissez Supprimer du contenu, ou 
utilisez Édition > Supprimer du contenu) pour ouvrir la boîte de dialogue Supprimer du 
contenu (Figure 13). Dans cette boîte de dialogue, plusieurs attributs de la cellule peuvent être 
supprimés. Pour tout supprimer dans une cellule (contenu et format), cochez Tout supprimer.
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Figure 13 : Boîte de dialogue Supprimer du 
contenu

Note
Si vous choisissez Héritage OpenOffice.org comme Raccourci clavier dans l'option 
Outils > Options > LibreOffice Calc > Compatibilité, le comportement des 
touches Suppr et Retour arrière est inversé.

Remplacer toutes les données dans une cellule
Pour supprimer les données et insérer de nouvelles données, tapez simplement par-dessus les 
anciennes données. Les nouvelles données conserveront le format d'origine.

Changer une partie des données dans une cellule
Il est parfois nécessaire de changer le contenu d'une cellule sans en supprimer tout le contenu, 
par exemple quand la phrase “Jean va partir” se trouve dans une cellule et doit être changée en 
“Jean va partir demain.” Il est souvent utile de le faire sans tout d'abord supprimer l'ancien contenu 
de la cellule.

La méthode est similaire à celle décrite ci-dessus, mais vous devez placer le curseur dans la 
cellule. Vous pouvez le faire de deux manières.

Utiliser le clavier
Après avoir sélectionné la cellule désirée, appuyez sur la touche F2 et le curseur sera placé à 
la fin de la cellule. Utilisez alors les flèches du clavier pour déplacer le curseur dans le texte de 
la cellule.

Utiliser la souris
Double-cliquez dans la cellule voulue (pour la sélectionner et placer le curseur à l'intérieur pour 
modification), ou cliquez pour sélectionner la cellule et ensuite déplacez le pointeur de la souris 
dans la ligne de saisie et cliquez à l'intérieur pour placer le curseur pour modification.
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Collage spécial dans une cellule
Vous pouvez utiliser la fonction de collage spécial pour ne recopier dans une cellule qu'une partie 
d'une cellule d'origine, son format ou le résultat brut de sa formule par exemple. Pour ceci, vous 
devez copier une cellule ou une plage dans le presse-papiers. Ensuite, vous pouvez sélectionner 
la cellule ou la plage de destination et :

• Sélectionner Édition > Collage spécial depuis la barre de menus

• Appuyer sur Ctrl+Maj+V

• Faire un clic droit et sélectionner Collage spécial dans le menu contextuel

La boîte de dialogue Collage spécial apparaît.

Figure 14 : Boîte de dialogue Collage spécial

Si vous conservez les options par défaut, le collage spécial équivaut à un collage normal. Vous 
pouvez décocher l'option Tout insérer et choisir les éléments pour ne recopier qu'une partie de la 
cellule d'origine.

Au lieu d'écraser le contenu d'une cellule, vous pouvez effectuer une des quatre opérations 
arithmétiques entre les contenus des cellules d'origine et de destination.

Vous pouvez insérer les cellules d'origine et déplacer les cellules de destination vers le bas ou 
vers la droite.

Il existe des commandes simplifiées de collage spécial dans le menu contextuel d'une cellule. Pour 
ceci, faites un clic droit et choisissez Coller seulement > Texte, Nombre ou Formule.

Insérer un champ dans une cellule
Vous pouvez insérer dans une cellule un champ correspondant à la date du jour, au nom de la 
feuille ou au nom du document. La cellule doit être en cours de modification. Pour ceci, placez le 
curseur dans la cellule comme décrit dans le sujet Changer une partie des données dans une 
cellule. Faites alors un clic droit, puis, dans le menu contextuel, choisissez Insérer des champs > 
Date ou Nom de feuille ou Titre.
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Attention
La commande Insérer des champs > Titre va insérer dans la cellule le nom du 
fichier et non pas le titre du document défini dans ses propriétés.

Formater les données

Les données dans Calc peuvent être formatées de plusieurs façons. Le formatage peut soit faire 
partie d'un style de cellules qui sera appliqué automatiquement, soit être appliqué manuellement à 
la cellule. Certains formatages manuels peuvent être appliqués en utilisant les icônes de barre 
d'outils. Pour plus de contrôles et d'options supplémentaires, sélectionnez la cellule ou la plage de 
cellules voulue, faites un clic droit à l'intérieur et sélectionnez Formater les Cellules. Toutes les 
possibilités de formatage sont abordées ci-dessous.

Note
Tous les paramétrages abordés dans cette section peuvent aussi être effectués en 
tant qu'éléments d'un style de cellule. Voir Chapitre 4 (Utiliser les styles et les 
modèles) pour plus d'informations.

Formater plusieurs lignes de texte
Des lignes de texte multiples peuvent être saisies dans une seule cellule en utilisant le renvoi à la 
ligne automatique ou des retours à la ligne manuels. Chaque méthode est utile dans différentes 
situations.

Utiliser le retour à la ligne automatique
Pour que le texte revienne à la ligne en fin de cellule, faites un clic droit et sélectionnez Formater 
les cellules (ou choisissez Format > Cellules depuis la barre de menus, ou appuyez sur Ctrl+1). 
Dans l'onglet Alignement (Figure 16), sous Propriétés, cochez Renvoi à la ligne automatique. Le 
résultat est montré ci-dessous (Figure 15).

Figure 15 : Retour à la ligne automatique
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Figure 16 : Boîte de dialogue Formater les cellules > Alignement

Utiliser les sauts de ligne manuels
Pour insérer un saut de ligne manuel pendant la frappe dans une cellule, appuyez sur Ctrl+Entrée. 
Pour modifier un texte, double-cliquez d'abord dans la cellule, puis cliquez à l'endroit où vous 
voulez faire un saut de ligne.

Quelle que soit la méthode (renvoi à la ligne automatique ou saut de ligne manuel), la hauteur de 
ligne est adaptée mais la largeur de cellule ne change pas. La Figure 17 montre le résultat de la 
saisie de deux sauts de ligne manuels après la première ligne de texte.

Figure 17 : Cellule avec sauts de ligne manuels

Ajuster le texte à la taille de la cellule
La taille de police des données d'une cellule peut être automatiquement ajustée pour remplir la 
cellule. Pour le faire, cochez l'option Ajuster à la taille de la cellule dans la boîte de dialogue 
Formater les cellules (Figure 16). La Figure 18 montre le résultat.

Figure 18 : Ajustement de la taille de police à la cellule
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Formater les nombres
Plusieurs formats de nombres différents peuvent être appliqués aux cellules en utilisant les icônes 
de la barre d'outils Formatage. Sélectionnez la cellule, puis cliquez sur l'icône correspondante. 
Certaines icônes peuvent ne pas être visibles avec le réglage par défaut ; faites un clic droit sur la 
barre puis choisir Boutons visibles et sélectionnez les icônes à afficher.

Figure 19 : Icônes de formats de nombres. De gauche à droite : monnaie, pourcentage, 
date, scientifique, standard, ajouter une décimale, supprimer une décimale

Depuis Calc 3.3, les nombres formatés avec le format de nombre Standard sont affichés avec 
autant de décimales que nécessaire. Avec les versions plus anciennes de Calc, un maximum de 2 
décimales était affiché avec ce format. Vous pouvez reproduire ce mode de fonctionnement en 
sélectionnant Outils > Options > LibreOffice Calc > Calcul et en choisissant Limiter les 
décimales pour le format de nombre général.

Pour plus de contrôle ou pour sélectionner d'autres formats de nombres, utilisez l'onglet Nombres 
(Figure 20) de la boîte de dialogue Formater les cellules :

• Appliquez l'un des types de données de la liste Catégorie aux données.

• Contrôlez le nombre de décimales et de zéros non significatifs.

• Saisissez une description de format personnalisée.

Le paramètre Langue détermine les paramètres locaux pour les différents formats comme l'ordre 
dans les dates et le symbole de l'unité monétaire.

Figure 20 : Formater les cellules > Nombres
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Formater la police
Pour choisir rapidement la police utilisée dans une cellule, sélectionnez la cellule, puis cliquez sur 
la flèche près du champ Nom de police dans la barre d'outils Formatage et choisissez une police 
dans la liste.

Astuce

Pour choisir d'afficher les noms de police dans leur police ou en texte simple, allez 
dans Outils > Options > LibreOffice > Affichage et cochez ou décochez 
Afficher l'aperçu des polices dans la section Liste des polices. Pour plus 
d'informations, voir Chapitre 14 (Paramétrer et personnaliser Calc).

Pour choisir la taille de la police, cliquez sur la flèche près du champ 
Taille de police dans la barre d'outils Formatage. Pour d'autres 
formats, vous pouvez utiliser les icônes Gras, Italique ou Soulignage.

Pour choisir une couleur de police, cliquez sur la flèche près de 
l'icône Couleur de police pour afficher la palette des couleurs. 
Cliquez sur la couleur voulue.

Pour définir des couleurs personnalisées, utilisez Outils > Options > 
LibreOffice > Couleurs. Voir Chapitre 14 pour plus d'informations.

Pour spécifier la langue de la cellule (utile pour permettre à plusieurs 
langues d'exister dans un même document et d'être vérifiées 
correctement (orthographe)), utilisez l'onglet Police de la boîte de 
dialogue Formater les cellules. Voir Chapitre 4 pour plus 
d'informations.

Choisir les effets de caractères
L'onglet Effets de caractères (Figure 21) de la boîte de dialogue Formater les cellules offre plus 
d'options concernant la police.

Surlignage et soulignage
Vous pouvez choisir parmi plusieurs sortes de surlignage et de soulignage (lignes continues, 
pointillés, tirets courts et longs, dans de multiples combinaisons) et la couleur de la ligne.

Barré
Vous pouvez barrer le contenu avec des lignes, des slash et des X.

Relief
Les possibilités de relief sont : relief (texte surélevé), empreinte (texte enfoncé), contour et 
ombre.

20 Saisir, Modifier et Formater des Données



Figure 21 : Formater les cellules > Effets de caractères

Paramétrer l'alignement et l'orientation des cellules
Certaines des icônes d'alignement et d'orientation des cellules ne sont pas affichées par défaut 
dans la barre d'outils Formatage. Pour les afficher, faites un clic droit sur la barre puis choisir 
Boutons visibles et sélectionnez les icônes à afficher.

Figure 22 : Alignement et orientation des 
cellules

Certaines des icônes d'alignement et d'orientation ne sont accessibles que si vous avez activé les 
langues asiatiques ou les scripts complexes (dans Outils > Options > Paramètres linguistiques 
> Langues). Si vous choisissez dans la liste une icône non disponible, elle n’apparaîtra pas dans 
la barre d'outils.

Pour plus de contrôle et de choix, utilisez l'onglet Alignement (Figure 16) de la boîte de dialogue 
Formater les cellules pour déterminer l'alignement horizontal et vertical et donner une rotation au 
texte.
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Si vous avez activé les langues asiatiques, la section Orientation du texte comporte alors une case 
à cocher supplémentaire (Mode de mise en page asiatique) sous la case Empilé verticalement, 
comme Figure 23.

Figure 23 : Options d'affichage des langues asiatiques

La différence de résultat entre Mode de mise en page asiatique coché ou non est montrée Figure
24.

Si vous avez activé les langues asiatiques, l'onglet Typographie asiatique est ajouté dans la boîte 
de dialogue. Cet onglet permet d'appliquer la liste des caractères interdits en début et en fin de 
ligne.

Figure 24 : Types 
d'empilements verticaux

Formater les bordures des cellules
Pour choisir rapidement un style de ligne et une couleur pour les bordures d'une cellule, cliquez 
sur la petite flèche près des icônes Style de ligne et Couleur de ligne dans la barre d'outils 
Formatage. Si les icônes Style de ligne et Couleur de ligne ne sont pas affichées dans la barre 
d'outils Formatage, faites un clic droit sur la barre puis choisir Boutons visibles et sélectionnez 
les icônes à afficher. Dans chaque cas, une palette de choix est affichée.

Pour plus de contrôle, comme l'espacement entre les bordures de la cellule et le texte, utilisez 
l'onglet Bordures de la boîte de dialogue Formater les cellules. Là, vous pouvez également définir 
un style d'ombre. Voir Chapitre 4 pour plus de détails.
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Note

Les propriétés de bordure de cellule s'appliquent à une cellule, et ne peuvent être 
modifiées que dans cette cellule. Par exemple, si la cellule C3 a une bordure 
haute (ce qui est visuellement équivalent à une bordure basse dans C2), cette 
bordure ne pourra être supprimée qu'en sélectionnant C3. Elle ne pourra pas être 
supprimée dans C2.

Formater l'arrière-plan des cellules
Pour choisir rapidement une couleur d'arrière-plan pour une cellule, cliquez sur la petite flèche 
près de l'icône Couleur d'arrière-plan dans la barre d'outils Formatage. Une palette de choix de 
couleurs, identique à la palette Couleur de police, est affichée.

Pour définir des couleurs personnalisées, utilisez Outils > Options > LibreOffice > Couleurs. 
Voir Chapitre 14 pour plus d'informations.

Vous pouvez également utiliser l'onglet Arrière-plan de la boîte de dialogue Formater les cellules. 
Voir Chapitre 4 pour plus de détails.

Mise en évidence des valeurs
Cette fonction affiche le contenu des cellules avec des couleurs différentes selon le type de 
données.

Sélectionnez Affichage > Mise en évidence des valeurs depuis la barre de menus, ou appuyez 
sur Ctrl+F8, pour activer ou désactiver cette fonction.

Les cellules de texte sont formatées en noir, les nombres en bleu et les formules en vert, quel que 
soit le formatage de cellule qui a été défini. Si cette fonction est active, les couleurs que vous avez 
définies pour le document ne seront pas affichées. Lorsque vous désactivez cette fonction, les 
couleurs définies par les utilisateurs réapparaissent.

Cette fonction peut également être activée en sélectionnant Outils > Options > LibreOffice Calc 
> Affichage et en cochant l'option Mise en évidence des valeurs. Cette action va appliquer la mise 
en évidence des valeurs à chaque fois que vous ouvrirez Calc, ce qui n'est peut-être pas ce que 
vous souhaitez.

Attention
Si vous avez sélectionné Affichage > Mise en évidence des valeurs, lors d'une 
impression ou d'un aperçu avant impression, la fonctionnalité est désactivée et les 
couleurs du formatage sont utilisées. Ce n'est pas le cas si vous avez utilisé 
l'option Mise en évidence des valeurs de Outils > Options > LibreOffice Calc > 
Affichage.

Auto-formatage des cellules et des feuilles

Vous pouvez utiliser la fonctionnalité AutoFormat pour appliquer rapidement un ensemble de 
formats de cellules à une feuille ou une plage de cellule sélectionnée.

1) Sélectionnez les cellules que vous voulez formater, avec les en-têtes de colonnes et de 
lignes.

2) Choisissez Format > AutoFormat.

3) Sélectionnez le format souhaité dans la liste.

4) Pour sélectionner quelles propriétés (format de nombres, police, alignement, bordures, 
motif, ajustement de la largeur et de la hauteur) sont à inclure dans un AutoFormat, cliquez 
sur Plus. Cochez ou décochez les options voulues. Cliquez sur OK.
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Figure 25 : Choisir un AutoFormat

Si vous ne voyez pas de changement de couleur du contenu des cellules, vérifiez si Affichage > 
Mise en évidence des valeurs n'est pas coché.

Note
Si la plage de cellules ne contient pas au moins 3 x 3 cellules, AutoFormat n'est 
pas disponible.

Définir un nouvel AutoFormat
Vous pouvez définir un nouvel AutoFormat disponible pour tous les classeurs.

1) Formatez une feuille.

2) Sélectionnez la plage de données définissant le nouvel AutoFormat, d'une dimension 
minimum de 4 x 4 cellules, ou choisissez Édition > Tout sélectionner.

3) Choisissez Format > AutoFormat. Le bouton Ajouter est maintenant actif.

4) Cliquez sur Ajouter.

5) Dans le champ Nom de la boîte de dialogue Ajouter un AutoFormat, tapez un nom 
significatif pour le nouveau format.

6) Cliquez sur OK pour enregistrer. Le nouveau format est désormais valable dans la liste 
Format de la boîte de dialogue AutoFormat.

Formater les classeurs en utilisant les thèmes

Calc est fourni avec un ensemble pré-défini de thèmes de formatage que vous pouvez appliquer à 
vos classeurs.

Il n'est pas possible d'ajouter des thèmes dans Calc, et ils ne peuvent pas être modifiés. 
Cependant, vous pouvez modifier leurs styles une fois que vous les aurez appliqués à un classeur.
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Pour appliquer un thème à un classeur :

1) Cliquez sur l'icône Sélectionner des thèmes dans la barre d'outils Outils. Si cette barre 
d'outils n'est pas visible, vous pouvez l'afficher en utilisant Affichage > Barres d'outils > 
Outils. La boîte de dialogue Sélection de thème apparaît. Cette boîte de dialogue liste les 
thèmes disponibles pour tout le classeur.

2) Dans la boîte de dialogue Sélection de thème, sélectionnez le thème que vous voulez 
appliquer au classeur. Dès que vous avez sélectionné un thème, certaines des propriétés 
des styles personnalisés sont appliquées au classeur ouvert et sont immédiatement 
visibles.

3) Cliquez sur OK. Si vous le souhaitez, vous pouvez alors aller dans la fenêtre Styles et 
formatage pour modifier certains styles (voir Chapitre 4 pour plus de détails). Ces 
modifications ne changent pas le thème ; elles changent uniquement l’apparence de ce 
classeur particulier.

Utiliser le formatage conditionnel

Vous pouvez paramétrer le formatage des cellules pour qu'il change selon les conditions que vous 
spécifiez. Par exemple, dans un tableau de nombres, vous pouvez afficher toutes les valeurs au-
dessus de la moyenne en vert et celles en-dessous de la moyenne en rouge.

Note
Pour appliquer un formatage conditionnel, Calculer automatiquement doit être 
activé. Choisissez Outils > Contenu des cellules > Calculer automatiquement.

Le formatage conditionnel est lié à l'utilisation des styles. Si vous n'êtes pas familier des styles, 
référez-vous au Chapitre 4. Une manière facile de paramétrer les styles voulus est de formater une 
cellule comme vous le voulez et cliquer sur l'icône Nouveau style à partir de la sélection dans la 
fenêtre Styles et formatage.

Une fois les styles paramétrés, voici comment les utiliser :

1) Dans votre classeur, sélectionnez les cellules auxquelles vous voulez appliquer un 
formatage conditionnel.

2) Choisissez Format > Formatage conditionnel > Formatage conditionnel dans la barre 
de menus. La boîte de dialogue Formatage conditionnel s'ouvre et affiche la liste des 
conditions déjà définies.

3) Cliquez sur Ajouter et saisissez la condition. Répétez cette étape autant que nécessaire.

4) Cliquez sur OK pour enregistrer. Les cellules sélectionnées sont désormais formatées 
dans le style correspondant.

Depuis Calc 3.5, avec le bouton Ajouter, vous pouvez ajouter autant de conditions que vous 
voulez pour votre formatage conditionnel. La Figure 26 illustre un formatage comportant trois 
conditions.

Reportez-vous à l'Aide pour plus d'informations et des exemples d'utilisation.
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Formatage selon la valeur de la cellule
Vous pouvez définir une condition portant sur la valeur d'une cellule en choisissant, dans le 
premier champ de définition de la condition, La valeur de la cellule est. La condition se définit alors 
comme Figure 26.

Figure 26 : Boîte de dialogue Formatage conditionnel selon la valeur de la cellule

Pour chacune des conditions, vous pouvez saisir :

Condition de valeur
Choisissez des conditions comme inférieur à, supérieur à, entre parmi d'autres.

Champ paramètre
Saisissez une référence, une valeur ou une formule dans le champ paramètre, ou dans les 
deux champs paramètres si vous avez choisi une condition qui nécessite deux paramètres. 
Vous pouvez également saisir des formules contenant des références relatives ou absolues.
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Style de cellule
Choisissez le style de cellule à appliquer si la condition spécifiée est remplie. Un aperçu du 
style choisi est alors visible. Vous pouvez définir un nouveau style en choisissant Nouveau 
style dans la liste déroulante. La boîte de dialogue Style de cellule est alors ouverte.

Formatage selon une formule
Vous pouvez définir une condition portant sur l'état Vrai ou Faux d'une formule en choisissant, 
dans le premier champ de définition de la condition, La formule est. La condition se définit alors 
comme Figure 27.

Figure 27 : Boîte de dialogue Formatage conditionnel selon une formule

Pour chacune des conditions, vous pouvez saisir :

Champ paramètre
Saisissez la formule à tester dans le champ paramètre. Si cette formule renvoie la valeur Vrai, 
le formatage sera appliqué. Vous pouvez saisir des formules contenant des références 
relatives ou absolues.

Style de cellule
Choisissez le style de cellule à appliquer si la formule est Vrai. Un aperçu du style choisi est 
alors visible. Vous pouvez définir un nouveau style en choisissant Nouveau style dans la liste 
déroulante. La boîte de dialogue Style de cellule est alors ouverte.

Formatage d'une plage de cellules avec une échelle de couleurs
Vous pouvez définir une condition portant sur une plage de cellules pour produire une échelle de 
couleurs en choisissant, dans le premier champ de définition de la condition, Toutes les cellules, 
et, dans le deuxième, Échelle de couleurs (2 entrées) ou Échelle de couleurs (3 entrées). La 
condition se définit alors comme Figure 28.

Figure 28 : Boîte de dialogue Formatage conditionnel pour une échelle de couleurs 
(2 entrées)
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Le résultat est semblable à celui de la Figure 29.

Figure 29 : Échelle de couleurs (2 entrées)

Formatage d'une plage de cellules avec une barre de données
Vous pouvez définir une condition portant sur une plage de cellules pour produire une barre de 
données en choisissant, dans le premier champ de définition de la condition, Toutes les cellules, 
et, dans le deuxième, Barre de données. La condition se définit alors comme Figure 30.

Figure 30 : Boîte de dialogue Formatage conditionnel pour une barre de données

Le résultat est alors semblable à celui de la Figure 31.

Figure 31 : Barre de données

Gestion des formatages conditionnels
Pour appliquer ensuite le même formatage conditionnel dans d'autres cellules :

1) Sélectionnez l'une des cellules où le formatage conditionnel a été appliqué.

2) Copiez la cellule dans le presse-papier.

3) Sélectionnez les cellules que vous voulez voir formatées de la même façon.

4) Choisissez Édition > Collage Spécial.
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5) Dans la boîte de dialogue Collage spécial, dans la zone Sélection, cochez uniquement 
l'option Formats. Assurez-vous que les autres options ne sont pas cochées. Cliquez sur 
OK.

Vous pouvez voir l'ensemble des formatages conditionnels définis dans votre feuille en choisissant 
Format > Formatage conditionnel > Gérer dans la barre de menus. La boîte de dialogue Gérer 
le formatage conditionnel s'ouvre, comme Figure 32. Vous pouvez à cet endroit éditer un 
formatage ou le supprimer.

Figure 32 : Boîte de dialogue Gérer le formatage conditionnel

Masquer et afficher les données

Quand des éléments sont masqués, ils ne sont ni visibles, ni imprimables, mais ils peuvent 
toujours être sélectionnés pour une copie si vous sélectionnez les éléments autour d'eux. Par 
exemple, si la colonne B est masquée, elle est copiée si vous sélectionnez les colonnes A et C. 
Quand vous avez à nouveau besoin d'un élément masqué, vous pouvez inverser le processus et 
afficher l'élément.

Pour masquer ou afficher les feuilles, les lignes ou les colonnes, utilisez les options du menu 
Format ou du menu contextuel (clic droit). Par exemple, pour masquer une ligne, sélectionnez tout 

Masquer et afficher les données 29



d'abord la ligne et choisissez ensuite Format > Ligne > Masquer (ou faites un clic droit sur l'en-
tête et choisissez Masquer).

Pour masquer ou afficher des cellules, sélectionnez-les et choisissez Format > Cellules dans la 
barre de menus (ou faites un clic droit et choisissez Formater les cellules). Dans la boîte de 
dialogue Formater les cellules, allez à l'onglet Protection de cellule. Le masquage ne sera effectif 
qu'après avoir protégé la feuille par Outils > Protéger le document > Feuille.

Figure 33 : Masquer ou afficher des cellules

Plans et groupes
Si vous masquez et affichez sans cesse les mêmes lignes ou colonnes, vous pouvez simplifier 
cette tâche en créant des groupes de lignes ou de colonnes, ce qui ajoute un ensemble de 
contrôles de plan pour masquer ou afficher les cellules d'un groupe qui sont faciles à utiliser et 
toujours disponibles.

Si la plage de cellules sélectionnée comporte des formules et si le contenu des cellules suit un 
schéma régulier, comme quatre cellules suivies d'un total, vous pouvez utiliser Données > Plan et 
groupe > AutoPlan pour que Calc ajoute des contrôles de plan selon le schéma. Sinon, vous 
pouvez faire un regroupement manuel en sélectionnant les cellules à grouper, puis en choisissant 
Données > Plan et groupe > Grouper ou en appuyant sur F12. Si vous n'avez pas sélectionné 
de lignes ou de colonnes, la boîte de dialogue Grouper apparaît et vous pouvez choisir de grouper 
les cellules sélectionnées en lignes ou en colonnes.

Après avoir fermé la boîte de dialogue, les contrôles de plan sont visibles entre les en-têtes soit de 
lignes, soit de colonnes, et les bords de la fenêtre courante. Les contrôles de plan ressemblent à la 
structure arborescente d'un gestionnaire de fichiers, et peuvent être fermés en sélectionnant 
Données > Plan et groupe > Masquer les détails. Ils sont réservés à un usage à l'écran et ne 
s'impriment pas.

Les contrôles de plan de base ont des signes plus ou moins au début d'un groupe pour afficher ou 
masquer des cellules. De plus, si les groupes sont imbriqués, les contrôles de plan comprennent 
des boutons avec des numéros pour masquer les différents niveaux.

Si vous n'avez plus besoin d'un groupe, placez le curseur de la souris dans l'une de ses cellules et 
sélectionnez Données > Plan et groupe > Dissocier ou appuyez sur Ctrl+F12. Pour supprimer 
tous les groupes d'une feuille, sélectionnez Données > Plan et groupe > Supprimer.
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Figure 34 : Contrôles de plan

Filtrer quelles cellules sont visibles
Un filtre est une liste de conditions que chaque saisie doit remplir pour être affichée. Vous pouvez 
utiliser trois types de filtres dans le sous-menu Données > Filtre.

Autofiltres
Les Autofiltres ajoutent une liste déroulante à la ligne la plus haute d'une colonne, liste qui contient 
les filtres les plus couramment utilisés. Ils sont rapides, pratiques et aussi utiles pour les textes que 
pour les nombres, car la liste comprend chaque valeur unique dans les cellules sélectionnées.

En plus de ces valeurs uniques, les filtres automatiques comprennent des options pour afficher 
toutes les valeurs, les 10 valeurs numériques les plus fortes, les valeurs vides ou non vides. 
Cependant, ils sont quelque part limités. En particulier, ils ne permettent pas l'usage des 
expressions régulières, et donc vous ne pouvez pas les utiliser pour afficher des contenus de 
cellules qui sont similaires, mais pas identiques. En revanche, ils permettent d'accéder directement 
au filtre standard que vous pouvez personnaliser pour cela (voir ci-dessous).

Exemple simple d'utilisation :

Figure 35 : Liste à filtrer

1) Cliquez dans l'une des cellules de la liste, ou sélectionnez la plage de cellules (A1:E12 ici).

2) Sélectionnez Données > Filtre > AutoFiltre dans la barre de menus.

3) Des listes déroulantes apparaissent au sommet de chaque colonne.
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4) Cliquez sur la flèche en haut de la colonne Employé et sélectionnez toutes les lignes de 
l'employé Yves en cliquant sur cette valeur dans la liste, puis en cliquant sur l'icône 
Afficher uniquement l'élément actif (voir Figure 36).

Figure 36 : Sélection de l'employé Yves

5) La liste est filtrée et n'affiche que les lignes avec cette valeur. Les numéros des lignes qui 
correspondent sont affichés et les numéros des autres lignes sont masqués. La flèche en 
haut de la colonne choisie pour filtrer les données change de couleur et comporte un 
indicateur dans son coin inférieur droit (Figure 37).

Figure 37 : Lignes filtrées et flèche modifiée

6) Vous pouvez alors filtrer les données par Catégorie, pour n'afficher que les ventes d'articles 
de golf, selon la même méthode que ci-dessus. La flèche en haut de la colonne indique 
également qu'elle est utilisée dans le filtre (Figure 38).
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Figure 38 : Résultat de la sélection de la Catégorie Golf

Les filtres peuvent être supprimés individuellement ou globalement.

• Pour supprimer tous les filtres, cliquez dans l'une des cellules de la liste, ou sélectionnez la 
plage de cellules. Depuis la barre de menus, sélectionnez Données > Filtre > Supprimer 
le filtre. Les données reviennent à l'état non filtré.

• Pour supprimer le filtre d'une colonne, cliquez sur la flèche en haut de cette colonne, puis 
cochez Tout et cliquez sur OK.

Filtres standard
Les filtres standard sont plus complexes que les filtres automatiques. Vous pouvez paramétrer 
jusqu'à huit conditions dans un filtre, en les combinant avec les opérateurs ET et OU. Les filtres 
standard sont plus utiles pour les nombres, bien que quelques opérateurs conditionnels comme = 
et <> (différent) puissent également être utilisés pour les textes.

D'autres opérateurs conditionnels pour les filtres standard comprennent des options pour afficher 
les plus grandes ou les plus petites valeurs, ou un pourcentage d'entre elles. Utiles en eux-
mêmes, les filtres standard sont également intéressants pour affiner des filtres automatiques.

Pour obtenir le même résultat que pour les Autofiltres à partir des données de la Figure 35, vous 
pouvez définir un filtre standard de la façon suivante.

Figure 39 : Filtre standard
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Filtres spéciaux
Les filtres spéciaux ont une structure identique aux filtres standard. Limités également à huit 
conditions (en-têtes inclus), leurs critères ne sont pas saisis dans une boîte de dialogue mais 
directement dans le classeur.

Pour filtrer les données de la Figure 35 de la même façon que ci-dessus :

1) Copiez les en-têtes de données dans une partie vide de la feuille.

2) Dans les cellules en dessous, insérez les données qui vont servir de filtre.

3) Pour que les filtres soient reliés par un ET, saisissez les données sous les en-têtes 
correspondants et sur la même ligne. Pour qu'ils soient reliés par un OU, saisissez les 
données sur des lignes différentes.

Figure 40 : Deux valeurs de filtre reliées par ET

4) Cliquez dans l'une des cellules de la liste, ou sélectionnez la plage de cellules.

5) Sélectionnez Données > Filtre > Filtre spécial. La boîte de dialogue Filtre spécial s'ouvre.

6) Sélectionnez les données du filtre spécial. Si vous les sélectionnez avec la souris, H1:L2 
dans l'exemple, durant leur sélection, elles sont entourées en rouge. Une fois la sélection 
effectuée, les données sont entourées en bleu et la boîte de dialogue contient la référence 
absolue à ces données (). Vous pouvez également saisir directement la référence des 
données du filtre spécial, ici H1:L2.

Figure 41 : Filtre spécial

7) Cliquez sur OK.
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Trier des enregistrements

Le tri modifie la disposition des cellules visibles dans la feuille. Dans Calc, vous pouvez utiliser 
simultanément jusqu'à trois critères de tri, qui sont appliqués l'un après l'autre. Les tris sont 
pratiques quand vous cherchez un élément particulier, et sont encore plus puissants combinés aux 
filtres.

De plus, le tri est souvent utile quand vous ajoutez de nouvelles données. Quand une liste est 
longue, il est habituellement plus facile d'ajouter des données en bas de la feuille, plutôt que 
d'insérer des lignes à leur bonne place. Après avoir ajouté des données, vous pouvez les trier pour 
mettre à jour la feuille.

Si les données sont disposées en colonne et comportent un en-tête au format texte, 
vous pouvez utiliser le tri rapide. Pour ceci, mettez en surbrillance les cellules à trier, 
puis cliquez sur les boutons de barre d'outils Tri croissant ou Tri décroissant. Vous 
pouvez également, si un Autofiltre est défini, utiliser Tri croissant ou Tri décroissant accessibles 
à partir de la flèche en haut de la colonne que vous désirez.

Figure 42 : Tri à partir de l'Autofiltre

Pour un tri plus élaboré, mettez en surbrillance les cellules à trier, puis sélectionnez Données > 
Trier pour ouvrir la boîte de dialogue Tri (Figure 43). Dans la boîte de dialogue, vous pouvez trier 
les cellules sélectionnées, dans l'ordre croissant (A-Z, 1-9) ou dans l'ordre décroissant (Z-A, 9-1).

(Nouveauté Calc 3.6) Le nombre de clés de tri est désormais illimité. La définition de la clé de tri 3 
fait apparaître la clé de tri 4, et ainsi de suite.

Figure 43 : Choisir les critères et les ordres de tri
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Astuce
Vous pouvez définir un ordre de tri personnalisé si les ordres alphanumériques 
fournis ne vous conviennent pas. Pour ce faire, voir “Définir une série de 
remplissage” page 10.

Dans l'onglet Options de la boîte de dialogue Tri (Figure 44), vous pouvez choisir les options 
suivantes.

Figure 44 : Options de tri

Respecter la casse
Pour deux entrées par ailleurs identiques, celle avec une lettre majuscule est placée avant 
celle avec une lettre minuscule dans la même position si le tri est décroissant ; si le tri est 
croissant, alors l'entrée avec une lettre majuscule est placée après celle avec une lettre 
minuscule dans la même position.

La plage contient des étiquettes de colonne
N'inclut pas les étiquettes de colonnes dans le tri.

Inclure les formats
Le formatage d'une cellule est déplacé avec son contenu. Si un formatage est utilisé pour 
distinguer différents types de cellules, alors utilisez cette option.

Activer le tri naturel
Prend en compte les nombres préfixés par une chaîne de caractères au lieu de s'en tenir au 
strict ordre alphanumérique. Vous pouvez avoir par exemple une plage de cellules contenant 
A1, A2, A3, …, A19, A20, A21. Si vous activez le tri naturel, vous obtiendrez un tri dans cet 
ordre. Si vous ne l'activez pas, vous obtiendrez A1, A10, A11, …, A19, A2, A20, A21, A3, A4, 
…, A9.
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Copier le résultat du tri vers
Détermine une adresse dans un classeur où copier le résultat du tri. Vous pouvez indiquer une 
référence, une plage de cellules nommée ou une plage de données.

Ordre de tri personnalisé
Sélectionnez le champ, puis choisissez dans la liste déroulante une des séries de remplissage 
définies dans Outils > Options > LibreOffice Calc > Listes de tri.

Direction
Détermine si les lignes ou les colonnes sont triées. Par défaut, le tri se fait de haut en bas (tri 
de lignes).

Rechercher et remplacer dans Calc

Calc propose deux façons de rechercher du texte dans un document : la barre d'outils Rechercher 
pour une recherche rapide et la boîte de dialogue Rechercher & remplacer.

Utiliser la barre d'outils Rechercher
Vous pouvez afficher ou masquer la barre d'outils Rechercher en utilisant Affichage > Barres 
d'outils > Rechercher, ou en appuyant sur Ctrl+F et Échap.

Tapez un terme à rechercher dans le champ Rechercher, et cliquez ensuite sur le bouton 
Rechercher le suivant (flèche vers le bas) ou Rechercher le précédent (flèche vers le haut). 
Pour trouver les autres occurrences de ce même terme, continuez de cliquer sur le bouton.

Utiliser la boîte de dialogue Rechercher & remplacer
Pour afficher la boîte de dialogue Rechercher & remplacer (Figure 45), utilisez le raccourci clavier 
Ctrl+H, choisissez Édition > Rechercher & remplacer dans la barre de menus ou sélectionnez 
l'icône Rechercher&Remplacer dans la barre d'outils Rechercher.

Dans les classeurs, vous pouvez recherchez des textes, des formules et des styles. Vous pouvez 
naviguer d'une occurrence à l'autre en utilisant Rechercher, ou vous pouvez mettre en surbrillance 
toutes les cellules qui correspondent en une fois en utilisant Tout rechercher, puis appliquer un 
autre format ou remplacer le contenu de la cellule par un autre.

Les textes et les nombres dans les cellules peuvent avoir été saisis directement ou être le résultat 
d'un calcul. La méthode de recherche que vous allez utiliser dépend du type de données que vous 
recherchez.

Astuce

Le contenu des cellules peut être formaté de différentes façons. Par exemple, un 
nombre peut être formaté en Monétaire, pour être affiché avec le symbole de la 
devise. Vous voyez le symbole monétaire dans la cellule, mais vous ne pouvez pas 
le rechercher sauf s'il a été appliqué via un style (cf. page 39).

Par défaut, Calc recherche dans la feuille courante. Pour rechercher dans toutes les feuilles d'un 
document, cliquez sur Plus d'options, puis cochez Recherchez dans toutes les feuilles.
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Attention Utilisez Tout remplacer avec prudence ; sinon, vous pouvez vous retrouver avec 
des erreurs très gênantes. Une erreur avec Tout remplacer peut nécessiter une 
recherche manuelle et mot par mot pour la réparer, si elle n'est pas découverte à 
temps pour pouvoir l'annuler.

Figure 45 : Boîte de dialogue Rechercher & remplacer étendue

Rechercher et remplacer des formules ou des valeurs
Vous pouvez utiliser la boîte de dialogue Rechercher & remplacer pour rechercher dans des 
formules ou dans les valeurs affichées qui résultent d'un calcul.

1) Pour ouvrir la boîte de dialogue Rechercher & remplacer, utilisez le raccourci clavier Ctrl+H 
ou sélectionnez Édition > Rechercher & remplacer.

2) Cliquez sur Plus d'options pour étendre la boîte de dialogue.

3) Sélectionnez Formules ou Valeurs dans la liste déroulante Rechercher dans.

• Formules examine les parties des formules.

• Valeurs examine le résultat des calculs.
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4) Tapez le texte que vous voulez rechercher dans le champ Rechercher.

5) Pour remplacer le texte par un texte différent, tapez le nouveau texte dans le champ 
Remplacer par.

6) Une fois votre recherche paramétrée, cliquez sur Rechercher. Pour remplacer le texte, 
cliquez à la place sur Remplacer.

Rechercher et remplacer des textes
1) Ouvrez la boîte de dialogue Rechercher & remplacer, cliquez sur Plus d'options pour 

étendre la boîte de dialogue et sélectionnez Valeurs ou Remarques dans la liste déroulante 
Rechercher dans.

2) Tapez le texte que vous voulez trouver dans le champ Rechercher.

3) Pour remplacer le texte par un texte différent, tapez le nouveau texte dans le champ 
Remplacer par.

4) Cliquez sur Rechercher, Tout rechercher, Remplacer ou Tout remplacer.

Quand vous cliquez sur Rechercher, Calc sélectionne la cellule suivante qui contient votre texte. 
Vous pouvez modifier le texte, puis cliquer à nouveau sur Rechercher pour avancer à la cellule 
suivante trouvée. Si vous fermez la boîte de dialogue, vous pouvez appuyer sur Ctrl+Maj+F pour 
trouver la cellule suivante sans ouvrir la boîte de dialogue.

Quand vous cliquez sur Tout rechercher, Calc sélectionne toutes les cellules qui contiennent 
votre saisie. Vous pouvez alors, par exemple, appliquer un style de cellules à toutes ces cellules 
en même temps.

Rechercher et remplacer des styles de cellules
Pour modifier rapidement toutes les cellules d'un style donné (non désiré) avec un autre style 
(préféré) :

1) Dans la boîte de dialogue Rechercher & remplacer étendue, sélectionnez Rechercher des 
styles. Les champs Rechercher et Remplacer par contiennent alors une liste de styles.

2) Sélectionnez les styles que vous voulez rechercher et remplacer.

3) Cliquez sur Rechercher, Tout rechercher, Remplacer ou Tout remplacer.

Utiliser les caractères génériques (expressions régulières)
Les Caractères génériques (ou expressions régulières) sont des combinaisons de caractères qui 
indiquent à LibreOffice comment rechercher quelque chose. Les expressions régulières sont très 
puissantes, mais pas très intuitives. Elles peuvent faire économiser du temps et du travail en 
combinant de multiples recherches en une seule.

Pour utiliser les caractères génériques et les expressions régulières pendant une recherche et un 
remplacement :

1) Dans la boîte de dialogue Rechercher & remplacer, cliquez sur Plus d'options pour avoir 
plus de choix. Dans cette boîte de dialogue étendue, cochez Expressions régulières.

2) Tapez le texte à rechercher, comprenant les caractères génériques, dans le champ 
Rechercher et le texte de remplacement (s'il y a lieu) dans le champ Remplacer par. 

3) Cliquez sur Rechercher, Tout rechercher, Remplacer ou Tout remplacer (non 
recommandé).

Astuce L'aide du logiciel décrit plusieurs expressions régulières et leur utilisation.
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Les points suivants peuvent intéresser les utilisateurs de Calc :

• Dans Calc, les expressions régulières sont appliquées séparément à chaque cellule. Cela 
signifie qu'une recherche de s.c va trouver sac dans la cellule A1, mais ne va pas trouver s 
dans la cellule A2 ni c (ou ac) dans la cellule A3. (L'expression régulière s.c signifie que le 
système va essayer de trouver s suivi de n'importe quel caractère suivi de c.)

• Quand une correspondance est trouvée, la cellule entière est en surbrillance, mais seul le 
texte trouvé sera remplacé. Par exemple, la recherche de homme aura pour résultat de 
mettre en surbrillance une cellule qui contient gentilhomme campagnard, et ne rien 
choisir dans le champ Remplacer par laissera la cellule avec gentil campagnard.

• Si Rechercher est utilisée deux fois à la suite, et si la seconde fois Sélection active 
seulement est coché, alors la seconde recherche sera évaluée dans la totalité de chaque 
cellule sélectionnée, et non uniquement dans la chaîne qui a fait que la cellule soit 
sélectionnée par la première recherche. Par exemple, la recherche de joh?n, puis 
l'activation de Sélection active seulement et la recherche de sm.th va trouver les cellules 
contenant John Smith et Smythers, Johnathon.

• Si une cellule contient un saut de ligne manuel (entré par Ctrl+Entrée), il peut être trouvé 
en utilisant l'expression régulière \n. Par exemple, si une cellule contient mur[saut de 
ligne]porteur, une recherche de r\np sans rien dans le champ Remplacer par laissera la 
cellule avec muorteur.

• Le saut de ligne manuel agit également pour marquer une “fin de texte” (similaire à une “fin 
de paragraphe” dans Writer), trouvé par le caractère spécial d'expression régulière $, en 
plus de la fin de texte dans une cellule. Par exemple, si une cellule contient mur[saut de 
ligne]porteur, alors une recherche de r$ remplacé par et laissera la cellule avec 
muet[saut de ligne]porteur. Notez qu'avec cette syntaxe, le saut de ligne n'est pas 
remplacé.

• L'utilisation de \n dans le champ Remplacer par va provoquer un remplacement par les 
caractères \n, et non par un saut de ligne.

• La boîte de dialogue Rechercher & remplacer a une option qui permet de rechercher dans 
des formules, des valeurs ou des remarques (pour rechercher dans les commentaires). 
Cette option s'applique à toutes les recherches, et non pas uniquement celles avec des 
expressions régulières. Une recherche de SOM avec l'option Formules va trouver une 
cellule contenant la formule =SOMME(A1:A6), ainsi qu'une cellule contenant le texte 
simple SOMMAIRE.

• Une recherche de l'expression régulière ^$ ne va pas trouver les cellules vides. C'est 
intentionnel, pour éviter les problèmes de performance quand on sélectionne un grand 
nombre de cellules. Notez que les cellules vides ne seront également pas trouvées si vous 
faites une recherche dans la sélection active seulement.

• Le fait de trouver les contenus de cellules en utilisant l'expression régulière .+ (ou similaire) 
et de les remplacer par & va en pratique ressaisir le contenu des cellules sans formatage. 
Cette technique peut être utile pour supprimer le formatage automatiquement appliqué par 
Calc lors de l'importation de données depuis le presse-papier ou un fichier mal formaté. 
Par exemple, pour convertir les textes constitués de chiffres en nombres, formatez tout 
d'abord les cellules en nombres et faites ensuite la recherche et le remplacement.

Voir Chapitre 7 (Formules et Fonctions) pour l'utilisation des expressions régulières dans les 
formules.
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